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1. Creating Projects and Importing Structures 
At the start of the session, change the file path to your chosen ​Working Directory in Maestro to make                                     
file navigation easier. Each session in Maestro begins with a default ​Scratch Project ​, which is not                               
saved. A Maestro project stores all your data and has a ​.prj extension. A project may contain                                 
numerous entries corresponding to imported structures, as well as the output of modeling-related                         
tasks. Once a project is created, the project is automatically saved each time a change is made. 

Structures can be imported from the PDB directly, or from your ​Working Directory using ​File >                               
Import Structures ​, and are added to the ​Entry List and ​Project Table​. The ​Entry List is located to                                   
the left of the ​Workspace ​. The ​Project Table can be accessed by ​Ctrl+T (Cmd+T) ​or ​Window >                                 
Project Table ​if you would like to see an expanded view of your project data. 

 

1. Double-click the ​Maestro​ icon 
○ (No icon? See ​Starting Maestro ​) 

 
Figure 1-1. Change Working Directory option. 

2. Go to ​File > Change Working Directory 
3. Find your directory, and click ​Choose 

 

 
Figure 1-2. Save Project panel.  

4. Go to ​File ​ ​> Save Project As  
5. Change the File name to ​FXa ​, click ​Save 

○ The project is now named 
FXa.prj 
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Figure 1-3. Get PDB File panel. 

6. Go to ​File > Get PDB 
7. For PDB IDs, type ​1fjs 
8. Click​ Download 

○ 1FJS is loaded into the ​Workspace 
○ A banner appears 

Note​: Banners appear when files have been 
imported, jobs ​incorporated​ into the ​Entry List​, 
or to prompt a common next step. Here, 
preparing the protein will be covered in the 
following section. 

 

 
Figure 1-4. The Workspace after the structure is imported from the PDB, with the Entry List and 
banner highlighted. 

Note​: By default the structure corresponding to the imported file is both ​included ​in the ​Workspace 
and ​selected​ in the ​Entry List​. Please refer to the Glossary of Terms for the difference between 
included​ and ​selected​. 
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2. Preparing Protein Structures for Glide Docking Model 
Structure files obtained from the PDB, vendors, and other sources often lack necessary information                           
for performing modeling-related tasks. Typically, these files are missing hydrogens, partial charges,                       
side chains, and/or whole loop regions. In order to make these structures suitable for modeling                             
tasks, we will use the Protein Preparation Wizard to resolve common structural issues. 

The Protein Preparation Wizard ​has processing, modification, and refinement tools that we will use                           
on the ​1FJS.pdb structure. In the Import and Process tab, the recommended minimal processing                           
tasks are checked by default. There are also options for filling in missing side chains and/or loops,                                 
depending on the needs of your structure. The Review and Modify tab shows you all the                               
components of the complex, in separate sections: Chains, Waters, Ligands, and Hets. Here, you can                             
choose which components of the complex to keep or remove. 

The Refine tab allows for more detailed modifications to the PDB structure. The H-bond assignment                             
section is used for optimizing the hydrogen bonding network – a process which samples water                             
orientations and flips Asn, Gln, and/or His side chains at a specified pH value. Adjusting the pH will                                   
change the protonation states of residues and ligands accordingly, and is useful if you want to                               
accurately reflect the experimental conditions. The Restrained minimization section fixes clashes                     
that can occur with adding hydrogens or filling missing sidechains. By default, an RMSD of 0.3 ​Å is                                   
used, minimizing both the hydrogens and heavy atoms via harmonic penalty constraints. Optionally,                         
hydrogen-only minimization can be chosen. 

2.1 Process the protein structure 

 
Figure 2-1. The Protein Preparation Wizard in 
the Favorites toolbar. 

1. In the Favorites toolbar, click ​ Protein 
Preparation 

○ The Protein Preparation Wizard 
opens 

Note​: You can also click ​Prepare ​ in the banner 
or find the Protein Preparation Wizard in the 
Task Tool 
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Figure 2-3. Import and Process tab of the 
Protein Preparation Wizard.  

2. In the Import and Process tab, click 
Preprocess 

○ A new entry is added to the ​Entry 
List​ and is ​included​ in the 
Workspace 

3. In the Protein Preparation - Problems 
panel, click ​OK 

○ The overlapping atoms are fixed in 
a later step 

Note​: The ligand bond order is fixed in the 2D 
Overlay 

2.2 Review and Modify the structure 

 
Figure 2-4. The Review and Modify tab before 
removing unwanted components. 

1. Click the ​Review and Modify ​ tab 
2. Under Chain Name, click chain ​L 

○ The ​Workspace ​ zooms to the 
chain 

3. Click ​Delete 
○ The smaller of the two chains is 

removed 
4. Shift-click to select all ​waters  
5. Click ​Delete 
6. In the Hets table, shift-click to select all 

GOL​ rows 
○ GOL standard for glycerol, which 

is a crystallographic artifact that is 
not biologically relevant 

7. Click ​Delete 

Note​: Depending on your system and research 
question, you may want to keep certain waters. 
See ​Protein Structure Preparation using the 
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Protein Preparation Wizard​ or ​Protein 
Preparation Wizard Panel Help​ for more details. 

 
Figure 2-5. Generate different protonation states 
for the ligand. 

8. In the Hets table,​ ​click ​A:Z34 (500)  
○ Protonation states are generated  
○ The lowest penalty state has been 

automatically checked 
9. Click through the ​different states 

○ Information is shown in red text at 
the bottom of the panel 

○ The ligand updates in the 
Workspace 

10.Check the ​S2 ​ box  

2.3 Refine the prepared structure 

 
Figure 2-6. The Refine tab of the Protein 
Preparation Wizard. 

1. Click the ​Refine ​ tab 
2. Under H-bond assignment, click 

Optimize  
○ This step takes ~1 minute 
○ A new entry is added to the ​Entry 

List 
○ The overlapping atoms have been 

corrected, and side chains that 
have been flipped are now labeled 
in the ​Workspace 

3. Under Restrained minimization, click 
Minimize 

○ This step takes ~1 minute 
○ A new entry is added to the ​Entry 

List 

Note: ​Clicking ​Interactive Optimizer ​ allows you 
to adjust any H-bond assignment 
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Figure 2-7. Change entry title. 

4. In the ​Entry List​, double-click ​1FJS - 
minimized  

5. Type ​1FJS_prepared ​to rename the 
entry 

3. Preparing a Ligand Structure 
In this section, we will prepare the co-crystallized ligand from the 1FJS structure for use in virtual                                 
screening. This is a typical step for ​cognate ligand ​docking, as it provides important validation prior                               
to screening a larger ligand data set. 

The following steps provide an example of how you would prepare a ligand data set using LigPrep.                                 
Ligand files can be sourced from numerous places, such as vendors or databases, often in the form                                 
of 1D or 2D structures with unstandardized chemistry. Before being used in a virtual screen, ligands                               
must be converted to 3D structures, with their chemistry properly standardized and extrapolated.  

3.1 Split the prepared structure  

 
Figure 3-1. Right-click to split an entry into 
different components. 

1. In the ​Entry List​, right-click on 
1FJS_prepared  

2. Choose ​Split > Into Ligands, Water, 
Other 

○ Two new entries appear in the 
Entry List 

3. Include ​ ​1FJS_prepared_ligand  
○ Only the ligand is displayed in the 

Workspace 
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3.2 Run LigPrep 

 
Figure 3-2. LigPrep application in the Task 
toolbar. 

1. Go to ​Tasks > Browse > LigPrep 
○ The LigPrep panel opens 

 
Figure 3-3. The LigPrep panel. 

2. For Use structures from, choose 
Workspace (1 included entry) 

3. Under Stereoisomers, choose ​Determine 
chiralities from 3D structure 

4. Change Job name to ​ligprep_1FJS 
5. Click ​Run 

○ A banner appears when the job 
has been ​incorporated 

○ A new group is added to the ​Entry 
List 

○ The number of ligands in this 
group is shown in parentheses   

Note​:  The Tile functionality is very useful for 
seeing the slight variations in chemistry for the 
generated structures. The Tile View can be 
turned on by clicking the ​ ​ in the Workspace 
Configuration Toolbar in the bottom right corner 
and then clicking the Tile button. 

7 



 
Figure 3-4. The Project Table with the Property 
Tree open. 

6. Type ​Ctrl+T (Cmd+T)​ to open the ​Project 
Table 

7. Click ​Tree ​ to open the Property Tree  
○ Different calculated properties can 

be toggled on and off 
○ Click the ​arrow​ next to each 

application to view more 
properties 

 

4. Visualizing Protein-Ligand Complexes 
In this section, we will explore ways to visualize structures in the ​Workspace ​. Object representation                             
can be changed in a number of ways using the Style toolbox. Presets offers the ability to quickly                                   
render a structure in a number of styles, similar to PyMOL, to facilitate easy visualization. Presets                               
can be used in a variety of ways, from de-cluttering your structure to creating publication-quality                             
images. We will analyze the protein-ligand complex by looking at the interactions, and generate a                             
custom set for some binding residues of interest, Finally, we will visualize the surface of the binding                                 
pocket and l save an image of the complex. 

4.1 Use the Style toolbox 

 
Figure 4-1. The Style toolbox with CPK 
representation highlighted. 

1. Include ​ entry ​1FJS_prepared  
2. Type ​L  

○ The ​Workspace ​ zooms to the 
ligand 

3. Under Quick Select, click ​L  
○ The ligand is selected 

4. Click​ Style  
5. Choose ​CPK ​ representation  

○ The ligand is rendered in 
space-filling (CPK) representation 

○ This is only applied to the ligand, 
since nothing else is selected in 
the ​Workspace 
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Figure 4-2. The Color Atoms menu. 

6. Click the ​Color Atoms arrow 
7. Choose ​Element (Custom Ligand) ​, and 

pick ​orange ​ from the secondary menu 
○ Ligand carbon atoms are orange  

8. Under Quick Select, click ​P  
○ The protein is selected 

9. Type ​Z  
○ The ​Workspace ​ is zoomed to view 

the selected structure 
10. In the Style toolbox, click ​Ribbons 

○ Ribbons are added to the protein 

 
Figure 4-3. The Edit Ribbon panel. 

11.Right-click on the ​ribbon 
○ The Edit Ribbon panel opens 

Note​: Use the predictive highlighting to know 
when you will click on the ribbon. 

12.Click ​Residue position ​in the color 
scheme 

13.Choose ​Single Color 

Note​: Click the box to the right of the color 
scheme to choose different colors 
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4.2 Apply a Preset style 

 
Figure 4-4. The Presets menu. 

1. Click ​Presets  
2. Choose ​Pretty 

○ The Workspace is rendered with 
ribbons, a green thick-tube ligand, 
and side chains are hidden 

3. Double-click ​Presets  
○ The ​Workspace ​ is redrawn with 

the Custom Preset 
○ The ​Workspace ​ zooms to the 

ligand 

4.3 Visualize Interactions 

 
Figure 4-5. The Interactions panel in the 
Workspace Configuration Toolbar. 

1. In the Workspace Configuration Toolbar, 
right-click ​Interactions  

○ The Interactions panel opens 
2. Turn on ​Non-covalent bonds 
3. Turn off ​Pi-cation ​interactions 

Note​: Clicking the color to the right of each 
interaction opens the Preferences panel, where 
the interaction visualization can be customized 

Note​: The threshold for Contacts/Clashes is set 
to 0.89 for bad and 0.75 for ugly. These values 
correspond to the ratio of the distance between 
the two atoms and the sum of their Van der 
Waals radii. 
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4.4 Create a custom set 

 
Figure 4-6. Select PHE 174, TRP 215 and ASP 
189. 

1. Type ​R ​ to switch to residue picking 
2. Ctrl+Click to select the binding site 

residues ​PHE 174 ​, ​TRP 215 ​ and ​ASP 
189 ​in the ​Workspace 

 
Note​: Residues can be located by residue 
number and type in the Structure Hierarchy 
 

 
Figure 4-7. Open Save as Custom Set panel. 

3. In the Structure Hierarchy, right-click on 
Current Selection 

4. Choose ​Save as Custom Set 
○ The Save Selection as Custom Set 

panel opens 

 
Figure 4-8. Save Custom Set. 

5. For Set Name, type ​1FJS Binding 
6. For Save as, choose ​Specific Atoms 
7. For Define by, choose ​Atom numbers 

within entry 
○ This will ensure that the selection 

will remain consistent when 
multiple entries are in the 
Workspace 

8. Click ​Save Set 
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Figure 4-9. Custom Sets section in the Selection 
Toolbar dropdown. 

Note​: Custom Sets can be accessed and 
edited through the Custom Sets section in 
the dropdown in the Selection Toolbar 

 

4.5 Generate and manipulate a surface 

 
Figure 4-10. More options in Quick Select. 

1. Under Quick Select, click ​…​ and choose 
Binding Sites 

2. Click​ Style ​and choose ​ Surface 
○ A solid gray surface is applied  
○ An S is next to the title in the ​Entry 

List​, click to see surface options 
 
Note​: Click  ​Surface (Binding Site) ​in the 
Favorites toolbar to perform the same task 
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Figure 4-11. The Surface Display Options panel. 

3. Right-click the ​surface 
4. Choose ​Display Options  

○ The Surface Display Options panel 
opens 

5. For Color Scheme, choose ​Electrostatic 
Potential 

6. Change the Min and Max values to ​-0.1 
and​ 0.1 ​, respectively 

7. Click ​OK 
○ The intensity of the surface colors 

is increased  

4.5 Generate a 2D interaction diagram 

 
Figure 4-12. Ligand Interaction Diagram in the 
Favorites toolbar. 

1. In the Favorites toolbar, click ​Ligand 
Interaction 

○ The 2D Workspace - Ligand 
Interaction Diagram opens 

 
Figure 4-13. The Ligand Interaction Diagram 
with Sync with 3D turned on and LID legend 
open. 

2. Check ​Sync with 3D ​ and rotate the 
ligand in the ​Workspace 

○ Ligand orientation is changed in 
the 2D representation 

3. Choose ​View > LID Legend 
 
Note​: Images can be saved via ​File > Save 
Screenshot 
 
Note​: The residue icon point indicates the 
direction of the sidechain 
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4.6 Save an image of the Workspace 

 
Figure 4-14. Save Image panel with expanded 
Options shown. 

1. Go to ​Workspace > Save Image As 
○ The Save Image panel opens 

2. Click ​Options >>  
3. Check ​Transparent background ​ and 

select ​300 ​ DPI 
4. Change File name to ​1FJS_binding_site 
5. Click ​Save 

○ A ​.png​ image of the ​Workspace ​ is 
saved to your ​Working Directory 

 
Note​: If an item is highlighted in the ​Workspace ​, 
the image is saved with the selection highlights 
 
Note​: Go to ​Tasks > Browse > Workspace 
and Project Table Operations ​ for more image 
options, including ​Ray Trace 

 

5. Conclusion and References 
In this tutorial, we imported and prepared a protein and ligand file, then visualized and analyzed the                                 
protein-ligand complex. A raw PDB file was made suitable for modeling purposes using the Protein                             
Preparation Wizard, and the ​cognate ligand was extrapolated using LigPrep in the same fashion that                             
would be used for a multi-ligand file. These steps would be the starting point for many                               
computational experiments, including docking (Glide), molecular dynamics simulations (Desmond),                 
and lead optimization (Prime, MM-GBSA). Structures visualization options were able to be chosen                         
manually using the Style toolbox, as well as with one click using Presets. The Workspace                             
Configuration toolbar allowed for toggling various components in the ​Workspace and the 2D view in                             
the  Ligand Interaction Diagram gave another way to analyze information. 

For further information, please see: 
Maestro 11 Training Portal 
Protein Preparation Wizard Panel Help 
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6. Glossary of Terms 

cognate ligand​ - a ligand that is bound to its protein target 

Entry List​ - a simplified view of the Project Table that allows you to perform basic operations such as 
selection and inclusion 

included​ - the entry is represented in the Workspace, the circle in the In column is blue 

incorporated​ - once a job is finished, output files from the Working Directory are added to the 
project and shown in the Entry List and Project Table 

Project Table ​ - displays the contents of a project and is also an interface for performing operations 
on selected entries, viewing properties, and organizing structures and data 

Scratch Project ​ - a temporary project in which work is not saved, closing a scratch project removes 
all current work and begins a new scratch project 

selected​ - (1) the atoms are chosen in the Workspace. These atoms are referred to as "the selection" 
or "the atom selection". Workspace operations are performed on the selected atoms. (2) The entry is 
chosen in the Entry List (and Project Table) and the row for the entry is highlighted. Project 
operations are performed on all selected entries 

Working Directory ​ - the location that files are saved 

Workspace ​ - the 3D display area in the center of the main window, where molecular structures are 
displayed 
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